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VIEWNET 3000 COMPUTER MANAGEMENT SYSTEM OVERVIEW 
 

The ViewNet 3000 blends the power of the computer with the world of multimedia 
to provide the ultimate learning experience.  This state-of-the-art system is cost 
effective and remarkably easy to operate.  Use it to revolutionize your classroom 
and energize your presentations, as you reach your exact audience with exactly the 
lesson material they need. 

 
 
      
 Revolutionize Your Classroom 
      

• Broadcast subject matter to individuals, groups, or the entire audience 
• From your computer workstation, take over any individual's keyboard and 

mouse for personalized attention 
• Share one individual's discovery or questions with another, with specific 

groups, or with everyone 
 
 
      
 Energize Your Presentations 
      

• Deliver subject matter to your audience from any source (hard drive, 
CD-ROM, camera, TV and countless others) 

• Work with prepared material on a real-time "chalk board" 
• Connect to the Internet and project a web site to each participant's 

computer screen 
• Analyze presentation effectiveness through instantaneous assessment of 

population responses 
 
 
      
 Reach Your Exact Audience 
      

• Interact with individuals or define groupings of unlimited number and variety 
• Provide a totally confidential environment that allows individuals to 

participate freely in the learning process 
• Invisibly monitor audience attention and progress 
• Extend your physical classroom with distance learning opportunities 

 
 
 
 

ENJOY YOUR VIEWNET 3000 COMPUTER MANAGEMENT SYSTEM 
 
 
 

Your satisfaction is important to us. 
Contact your local Nida representative with questions or comments. 
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INTRODUCTION TO THE SECTIONS OF THIS MANUAL 
 
 

OPERATION 
This section describes how to use the ViewNet 3000.  It provides you 
with the details you need to tap all of the available functions and 
derive the maximum advantage from your system 

 
If a Nida representative has completed your installation and setup 
(including addressing and testing), you are ready to begin 
operating your ViewNet 3000 system.  Start with the BASICS on 
Page 5 or the DETAILS on Page 40. 

 
 

SETUP 
This section describes how to configure your system.  It details 
the settings that need to be in place for establishing the controls 
necessary to operate the ViewNet 3000. 
 

 
      
 

INSTALLATION 
This section identifies all the system components and describes in 
detail the connections that must be made to get you started with 
your ViewNet 3000. 

 
 

      
 

BASICS 
Experienced users may need only the basic steps of a process to 
accomplish a specific task with their ViewNet 3000.  BASICS are 
presented at the front of the manual for easy access to the most 
frequently used processes. 

 
 
 

 DETAILS 
For full understanding of the ViewNet 3000 system functions, 
users may find in-depth explanations of the components and 
functions to be helpful.  DETAILS are provided to elaborate on the 
steps that are outlined in BASICS. 

 
Because the ViewNet 3000 is designed to satisfy many user 
needs, some functions of the system may not be required by all 
users.  Please contact your local representative if you have 
questions about your ViewNet 3000 configuration. 
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To realize the full potential of your ViewNet 3000 system, it is important to perform 
all of the following steps in the order shown below: 

     
 

SEQUENCE FOR OPTIMUM RESULTS 

STEP ACTION 

 
 
 
 

BASICS 

 
 
 
 

DETAILS 

 
 

 INSTALLATION 
 

1. Install your system hardware n/a Page 62 

2. Install the ViewNet software Page 17 n/a 

 
 

 SETUP 
 
 

3. Create a ViewNet Layout file Page 12, then 13 Page 21 

4. Create a ViewNet Control file Page 14 Page 36 

5. Address your ViewNet units Page 15 Page 37 

6. Test your ViewNet system Page 16 Page 38 

 
 

 OPERATION 
 
 

7. Operate the ViewNet system Page 5 Page 40 
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VIEWNET SOFTWARE 
 

The ViewNet software consists of two separate applications: ViewNet Layout and 
ViewNet Control. 
 

VIEWNET LAYOUT is used to set up a graphical representation of your 
classroom that serves as your control panel in ViewNet Control. 
 
VIEWNET CONTROL enables you to operate the ViewNet 3000 system.  From 
ViewNet Control, you can broadcast, scan, monitor, or take over networked 
Student workstations.  
 
 
The ViewNet Control software should be installed on any computer that will be 
used as a controlling computer.  Normally, only one computer, referred to as the 
Instructor computer, is designated as the controlling computer. 
 
 
 
 
 

 
HARDWARE REQUIREMENTS 
 

$ VGA Monitor and Adapter 
 
$ PS/2 Mouse* 
 
$ PS/2 Keyboard** 
 
 

* PS/2 Mouse is recommended; however, a serial mouse may be used with an 
adapter.  Important Note:  If any one of your computer stations uses a serial 
mouse, all the other stations must also use serial mice. 

 
 

** PS/2 Keyboard is recommended; however, a standard keyboard may be used 
with an adapter.  Keyboard style may differ from station to station without 
adversely affecting system operation.  
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VIEWNET OPERATION – MAJOR FUNCTIONS 
 

ViewNet Control software is installed on the computer(s) that will direct the activity 
of classroom workstations at which individual, self-paced study is being pursued.  
Normally, there is only one controlling unit.  We use the term Instructor when 
referring to the controlling workstation and Student when referring to the 
supervised units. 
 

The major functions that can be performed with the ViewNet 3000 are: 
      

• BROADCAST 

• TAKEOVER 

• MONITOR/SCAN 

 

VIEWNET  OPERATION  MAJOR  FUNCTIONS 

FUNCTION NAME ACTION 

  BROADCAST Allows a selected display to be sent to any 
designated workstation monitor(s), 
temporarily replacing the display that was 
in the process of being viewed. 

  TAKEOVER Allows the Instructor workstation to control 
the keyboard and mouse functions of any 
designated Student workstation.   

  MONITOR Allows the display of any designated 
workstation to be shown on the Instructor 
monitor. 

      SCAN Allows the display of each Student 
workstation to be shown in turn on the 
Instructor monitor, cycling through the 
classroom in a pre-determined order at a 
designated rate. 

 
 
      

These functions can be configured in various ways, depending on the menu options 
selected.  Processes are outlined in the following Operation BASICS. 
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         OPERATION BASICS:   1.  BROADCAST 

BROADCAST INSTRUCTOR DISPLAY TO EVERYBODY 

STEP COMMENTS 

1. Right-click the Instructor icon. The Instructor menu will appear. 

2. Select Broadcast from the 
Instructor menu. 

If the default settings are unchanged, the 
display on the Instructor monitor will be sent 
to all Student workstations. 

3. Click the Stop button on 
the ViewNet Control 
toolbar. 

System status will return to Ready.  Monitors 
of all Student workstations will return to the 
displays that appeared when Broadcast was 
activated. 

For further information:  
 See Page 48 to customize a menu and restrict Broadcast to an individual monitor or to 
specific groups instead of everyone.   See Page 53 to reconfigure the system parameters 
for the Broadcast toolbar button. 

Alternate selection method:   
If default settings are unchanged, double-click the Instructor icon to activate the Broadcast, 
Everybody function.  To reassign the double-click, see Page 51. 

BROADCAST FROM ONE STUDENT STATION TO EVERYBODY 

STEP COMMENTS 

1. Right-click the Student icon 
representing the selected 
monitor display. 

The Student menu will appear. 

2. Select Broadcast from the 
Student menu. 

If the default settings are unchanged, the display 
on the selected Student monitor will be sent to 
all other Student monitors as well as to the 
Instructor monitor. 

3. Click the Stop button on 
the ViewNet Control 
toolbar. 
or 
Press [IR] on the  
keypad. 

System status will return to Ready.  
 
Monitors of all Student workstations will return 
to the displays that appeared when Broadcast 
was activated. 

For further information:  
 See Page 48 to customize a menu and restrict Broadcast to an individual monitor or to 
specific groups instead of everyone.   See Page 53 to reconfigure the system parameters 
for the Broadcast toolbar button. 
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         OPERATION BASICS:    2.  TAKEOVER 
 

STEP COMMENTS 

1. Right-click the selected Student 
icon. 

The Student menu will appear. 

2. Select Monitor from the Student 
menu. 

If the default settings are unchanged, the display 
on the selected Student monitor will appear on 
the Instructor monitor. 
 
The process will be accomplished without 
disturbing the selected student's activity. 

3. When the selected Student 
display appears on the Instructor 
monitor: 
 
Select Takeover from 
the toolbar. 
 
or 
 
Press [4] on the keypad. 
 

The Instructor mouse will control the pointer on 
the Student display.  The Instructor keyboard 
will enter text or commands on the Student 
workstation. 
 
 
 

 Select Takeover from the 
toolbar. 
 
or 
 
Press [4] on the keypad. 

Toggle off the Takeover function, returning 
control of the mouse and keyboard to the 
Student workstation.  The Student display will 
remain on the Instructor monitor. 

Note: 
 
See subsequent Operation Basics for details on when the Takeover function may be 
applied. 
 

 



ViewNet 3000 – Operation Basics  
  
 

  Copyright © 2000 
 

8 

 

         OPERATION BASICS:    3.  MONITOR A STUDENT WORKSTATION 
 

STEP COMMENTS 

1. Right-click the selected Student 
icon. 

The Student menu will appear. 

2. Select Monitor from the Student 
menu. 

If the default settings are unchanged, the display 
on the selected Student monitor will appear on 
the Instructor monitor. 
 
The process will be accomplished without 
disturbing the selected student's activity. 

Takeover and Secondary Broadcast functions are available. 

3a. Select Takeover from 
the toolbar. 
 
or 
 
Press [4] on the keypad. 

The Instructor mouse will control the pointer on 
the Student display.  The Instructor keyboard 
will enter text or commands on the Student 
workstation. 
 
 

3b. Select Takeover from the 
Student menu. 
 
or 
 
Press [4] on the keypad. 

Toggle off the Takeover function, returning 
control of the mouse and keyboard to the 
Student workstation.  The Student display will 
remain on the Instructor monitor. 

4a. Select Secondary 
Broadcast from the 
Student menu. 
 
or 
 
Press [B] on the keypad. 

If the default settings are unchanged, the display 
on the selected Student monitor will appear on 
all the Student workstations as well as on the 
Instructor monitor. 
 
 

4b. Select Secondary Broadcast 
from the Student menu. 
or 
Press [B] on the keypad. 

Toggle off the function, returning all Student 
monitors to their original displays.   

Continued on next page
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         OPERATION BASICS:   3.  MONITOR A STUDENT WORKSTATION, 
CONTINUED 

STEP COMMENTS 

5. Before toggling off the Takeover 
function from Step 3b, select 
Secondary Broadcast. 

The mouse and keyboard commands displayed 
on the selected Student station will also appear 
on all other Student monitors. 

6. Click the Stop button on 
the ViewNet Control 
toolbar. 
 
or 
 
Press [IR] on the  
keypad. 
 

System status will return to Ready.  The monitor 
of the selected Student workstation will return 
to the display that appeared when Monitor was 
activated. 

Alternate selection method:  
  
If default settings are unchanged, double-click the Student icon to activate the Monitor 
function. 
 

For further information: 
 
See Page 48 to customize a menu and restrict the Secondary Broadcast to an individual 
monitor or to specific groups instead of everyone. 
 
See Page 53 to reconfigure the system parameters for the Broadcast toolbar button. 
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         OPERATION BASICS:     4.  SCAN 
 

STEP COMMENTS 

1. Right-click the Instructor icon. The Instructor menu will appear. 

2. Select Scan from the Instructor 
menu. 

If the default settings are unchanged, each 
Student display will appear in sequence on the 
Instructor monitor. 

3. Modify the sequence of the scan if desired: 

3a. Select Start Over on the 
toolbar. 
or 
Press [1] on the keypad. 

The number 1 Student monitor display will be 
shown on the Instructor monitor and the scan 
sequence will resume in order from there. 

3b. Select Reverse on the 
toolbar. 
or 
Press [3] on the keypad. 

The scan sequence will descend in Student 
workstation order from the display that is on the 
Instructor monitor when Reverse is activated. 

3c. Select Forward on the 
toolbar. 
or 
Press [A] on the 
keypad. 

Resume the scan sequence in ascending Student 
workstation order from the display that is on the 
Instructor monitor when the Forward function is 
activated. 

The Pause function is available. 

4a. When the selected 
Student display appears 
on the Instructor 
monitor: 
Select Pause from the toolbar. 
or 
Press [2] on the keypad. 

The scan sequence will freeze temporarily, with 
the selected Student display remaining on the 
Instructor monitor. 

Note: 
All Navigation buttons are active during Pause and can be used to choose a different 
Student workstation for the paused display on the Instructor monitor. 

Continued on next page
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         OPERATION BASICS:     4.  SCAN, CONTINUED 
 

STEP STEP 

4b. Press Forward or Reverse to 
resume the scan from where it 
was stopped. 

Forward will cause the scan to resume in 
ascending order; Reverse, in descending order. 

Takeover and Secondary Broadcast functions are available. 

5a. Select Takeover from 
the toolbar. 
or 
Press [4] on the keypad. 

The Instructor mouse will control the pointer on 
the Student display.  The Instructor keyboard 
will enter text or commands on the Student 
workstation. 

5b. Select Takeover from the 
toolbar. 
or 
Press [4] on the keypad. 

Toggle off the function, returning control of the 
mouse and keyboard to the Student workstation. 
The Student display will remain on the Instructor 
monitor. 

6a. Select Secondary 
Broadcast from the 
toolbar. 
or 
Press [B] on the keypad. 

If the default settings are unchanged, the display 
on the selected Student monitor will appear on 
all the Student workstations as well as on the 
Instructor monitor. 
 
 

6b. Select Secondary Broadcast 
from the toolbar. 
or 
Press [B] on the keypad. 

Toggle off the function, returning all Student 
monitors to their original displays.   

6c. Before toggling off the Takeover 
function from Step 5b, select 
Secondary Broadcast. 

The mouse and keyboard commands displayed 
on the selected Student station will also appear 
on all other Student monitors. 

7. Click the Stop button on 
the toolbar. 
or 
Press [IR] on the  
keypad. 

System status will return to Ready. 

For further information: 
 
See Page 26 to resequence the scan order and Page 54 to alter the scan rate system 
parameter. 



ViewNet 3000 – Setup Basics  
  
 

  Copyright © 2000 
 

12 

            SETUP BASICS:    1.  CREATE A VIEWNET LAYOUT FILE 
 

STEP ACTION COMMENTS 

1. Open ViewNet Layout from 
your desktop. 

 

2. Open a New layout dialog box. Select File|New. 
or 
Click the New button on the toolbar. 

3. Click the red Add 
button to create a unit 
icon. 

The new icon will be displayed in the upper left 
hand corner of your layout dialog box. 

4. Drag the icon to the desired 
position on the layout. 

The dialog box grid will assist you in lining up 
icons and organizing your layout. 

5. Click the red Add button to 
create additional unit icons. 

Highlight an icon and click Add to duplicate the 
icon in the highlighted icon's position. 
 
Click Add without first highlighting an icon to 
place a new icon in the upper left corner of the 
dialog box. 

6. Arrange all the icons to 
represent your classroom 
layout. 

 

7. Set the icon properties. See Setup Basics #2. 

For further information: 
 
See Page 20 for the Toolbar description. 
 
Begin on Page 18 for more information on the ViewNet Layout function. 
 

 



 ViewNet 3000 – Setup Basics 
  
 

Copyright © 2000  13 
 

 

           SETUP BASICS:     2.  SET ICON PROPERTIES 
 

STEP ACTION COMMENTS 

1. On the ViewNet layout created 
in Setup Basics #1, right-click 
the first icon in your classroom 
layout. 

The Properties dialog box will appear, with the 
Appearance tab displayed. 

2. Enter a unique name for the 
icon in the Label field. 

 

3. Set the Border and Fill 
parameters as desired. 

 

4. Ensure the Default Type is 
correct and matches the Image. 

 

5. Select the ViewNet tab and 
place a checkmark in the Active 
ViewNet Unit block. 

Ensure the box is activated for ViewNet units.  
Deselect if the icon is an empty placeholder. 

6. Click OK.  

7. Right-click each icon and repeat 
Steps 2-6. 

Note:  To change the label only, left-click the 
icon label.  Left-click a second time to activate 
the Rename function. 

8. Select View|Addresses. The ViewNet addresses will be displayed on 
each unit icon. 

9. Highlight the desired unit icon, 
hold down the CONTROL key, 
and click the Bring to Front or 
Send to Back button until the 
desired number is displayed. 

When you are satisfied with your layout and 
address flow, proceed to Step 10. 

10. Save the graphical layout. Select File|Save As from the File menu. 
or 
Click the Save button. 

11. Select File|Exit. The ViewNet Layout application will close.  Go 
on to create a ViewNet Control file as directed 
by Setup Basics #3 on Page 14. 

For further information: 
      
Begin on page 24 for more information on the Icon Properties function. 
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           SETUP BASICS:     3.  CREATE A VIEWNET CONTROL FILE 
 

STEP ACTION COMMENTS 

1. Open ViewNet Control from 
your desktop. 

 

2. Open a New file. Select File|New. 
or 
Click the New button on the toolbar. 

3. Highlight the .VNL file created 
in ViewNet Layout. 

 

4. Click Open. The .VNL file representing a graphical layout of 
your classroom will be displayed. 

5. Save the file as a .VNC file. Select File|Save As. 
or 
Click the Save button on the toolbar. 

6. If the file already exists, 
Windows will prompt you about 
replacing it.  Click Yes to 
continue. 

The .VNC file will be displayed. 

7. Click Close.  

For further information: 
 
Begin on Page 36 for more information on the ViewNet Control file function. 
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           SETUP BASICS:     4.  ADDRESS YOUR VIEWNET UNITS 
 

STEP ACTION COMMENTS 

1. Open ViewNet Control from 
your desktop. 

 

2. Open the desired .VNC file. Select File|Open. 
or 
Click the Open button on the toolbar. 

3. Select Mode|Address. The Address menu will appear on the menu bar.

4. Select Address|Start. The number 1 unit icon will flash an alternating 
yellow and green border. 

5. Attach a keypad to the number 
1 workstation if there is not one 
already connected. 

If your ViewNet system has only one keypad, 
move it in turn from the Instructor station to 
each unit being addressed during this process. 

6. Press [IR] on the 
keypad that is 
attached to the number 
1 workstation. 

A beep will sound from the keypad, indicating 
that addressing is complete. 
      
In the ViewNet Control file window on the 
Instructor monitor, the number 1 icon border 
will change to blue. 
      
Note: If your ViewNet system has been 
previously addressed, you may have to reset 
each unit by removing power from the unit or 
pushing the Reset switch (#9, shown on 
Page 58). 

7. Repeat Steps 5 and 6 for each 
workstation. 

Use the Navigation buttons to reverse, skip, or 
stop the addressing process. 

8. Select Address|Stop or click 
the Stop button on the toolbar. 

 

9. Select Mode|Idle. Idle mode puts the system in a standby status, 
which allows time to set up for the test. 

For further information: 
 
See Pages 34 and 35 for the ViewNet Control Toolbar and Keypad descriptions. 
 
Begin on Page 37 for more information on the Addressing function and the status indicated 
by the icon border color. 
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           SETUP BASICS:     5.  TEST YOUR VIEWNET SYSTEM 
 

STEP ACTION COMMENTS 

1. Open ViewNet Control. Use the icon on your desktop. 

2. Open the desired .VNC file. Select File|Open. 
or  
Click the Open button located on the toolbar. 

3. Select Mode|Test. The test routine systematically moves from one 
ViewNet unit to the next. 

4. Examine the display on the 
Student workstation for correct 
RGB color. 

Mismatched color indicates crossed or 
disconnected video cables. 

5. Press the keys on the ViewNet 
keypad. 

Characters will be displayed in the Whiteboard 
area of the test screen.  You may want to 
increase the test rate to 30 sec in Options| 
System to be able to test the entire keypad. 

6. To pause the test: 
Press [2] on the 
Instructor keypad. 
or 
Select Pause  
on the toolbar. 

To continue: 
Press [A] on the Instructor keypad. 
 
or 
 
Select Forward on the toolbar. 

7. To stop the test:  
Press [IR] on the  
Instructor keypad. 
or 
Select Address|Stop. 

If [IR] is used, the system will be set to 
Mode|Idle after 5 seconds. 
 
If Stop is used, the process will stop 
immediately. 

8. Select Mode|Normal Operation. You are now ready to operate your ViewNet.  
Refer to Page 5 for Operation Basics. 

For further information: 
 
See Pages 34 and 35 for the ViewNet Control Toolbar and Keypad descriptions. 
 
Begin on Page 38 for more information on the Testing function. 
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SOFTWARE INSTALLATION 
 
The ViewNet Control software is installed on the computer(s) that will direct the 
activity of classroom workstations at which individual, self-paced study is being 
pursued. 
 
Normally, only one computer, referred to as the Instructor computer, is designated 
as the controlling computer. 

 

                SOFTWARE INSTALLATION 

STEP ACTION COMMENTS 

1. Insert the ViewNet CD ROM 
into your CD ROM drive. 

If your CD ROM is not set up to autorun, select 
Start|Run and enter X:\install.exe (where X = 
the drive letter of your CD ROM). 
      
Note:  For Windows NT and Windows 2000 
workstations, log in as an administrator and 
run X:\install /admin so that the registration 
information will be available to all users. 

2. Click the ViewNet Installation 
Wizard. 

The Nida Installation Wizard dialog box will be 
displayed. 

3. Click the ViewNet 3000 Control 
icon. 

 

4. Read the Software License 
Agreement and click Accept if 
you agree to the terms of the 
agreement. 

If you do not accept the terms, click Exit to end 
the installation routine. 
 
Accept will display the Directory Setup dialog 
box. 

5. Enter the path of the directory 
where the ViewNet Control 
software will be loaded, and 
click Next. 

The Installation Wizard sets a default path of 
C:\Nida98. 
 
 

6. Enter the registration 
information and click Next. 

The installation routine will begin. 
 
Note:  The Registration number is found on your 
Nida Registration Information Sheet. 

7. When the installation is 
complete, click OK. 

The Nida Installation Wizard dialog box will be 
displayed. 

8. Click Exit. The ViewNet software will be installed.  
ViewNet Layout and ViewNet Control icons will 
be displayed on the desktop. 
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VIEWNET LAYOUT 
 
Before you can run ViewNet 3000, you must use ViewNet Layout to create a file 
that graphically represents your classroom.   
 

      
This file: 

      
• has a .VNL extension (VNL for ViewNet Layout). 

 
• provides you with a "control panel" for operating ViewNet 3000 

from ViewNet Control. 
 
 

You will need to create one layout file for each classroom or ViewNet system, and 
from that one file, you can build any number of additional control files.  We will 
discuss control files in the next section. 

 
 

Double-click the ViewNet Layout icon to open the ViewNet Layout application.  
The title screen of the program contains a menu and tool bars for creating the 
graphical files. 
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VIEWNET LAYOUT WINDOWS 
 
 

Menu Bar 
 

      
 
The ViewNet Layout menu bar contains the File, Edit, View, and Help drop-down 
menus. 
 
 
The Edit menu is disabled until a file is opened or created. 

 
 
      

 File 
The File menu is a basic Windows menu that allows you to create, open, close, 
and save files. 
 
One additional item included in this menu is Layout Properties.  The Layout 
function is used to load alternate icon libraries available from Nida. 

 
 
 

 Edit 
The Edit menu is similar to a word processor edit menu.  When a file is open, 
the functions of copy, cut, and paste are active. 

 
 
 

 View 
The View menu enables and disables the display of the Toolbar and Status Bar. 
 
When the menu item Addresses is checked, ViewNet addresses are displayed on 
the classroom icons.  We will discuss this in detail later in this manual. 

 
 
 

 Help 
The Help menu displays the ViewNet Layout version number and registration 
information.  Nida personnel may ask you for these details during a technical 
support call. 
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VIEWNET LAYOUT WINDOWS, continued 
 

Toolbar 
 
 

 
The ViewNet Layout toolbar contains buttons for accessing or performing certain 
operations.  Only the New and Open buttons are active until a file is opened. 

 
 

 New button 
The New button performs the same function as the selection of File|New from 
the menu bar.  It acts as a shortcut to open a clean work window for creating a 
classroom layout file. 
 

      
 Open button 

The Open button is also a shortcut for an item on the File menu.  When 
selected, it displays the Open dialog box where the existing .VNL files are listed. 
 

      
 Save button 

This button saves the current file with its current file name.  If selected when a 
new file is on the screen, it will automatically open the Save As dialog box. 
 

      
 Add ViewNet Unit button 

This button is used to add graphic icons to your classroom layout that represent 
the various ViewNet units on your system. 
 

      
 Cut, Copy, and Paste buttons 

These shortcut buttons perform the same standard word processor functions 
that are found on a typical Edit menu.  Highlight an item on your screen and 
select a button to apply the function to the item. 
 

      
 Send To Back and Bring To Front buttons 

These buttons move a highlighted item either to the top of a group of items 
(Bring to Front) or to the bottom of a group of items (Send to Back).  They are 
used for assigning an address sequence to a classroom layout. 
 

      
 Print button 

The Print button is used as a standard shortcut to the Print dialog box. 
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CREATING A VIEWNET LAYOUT FILE 
 

You will need to build one classroom layout for each classroom or ViewNet system. 
 
 Once a layout is created, one or more control files can be built from it. 

 
 
 
 VIEWNET LAYOUT WINDOW 
 

Click File|New or the New button on the toolbar to access the ViewNet Layout 
window. 
 
 
The grid for laying out your classroom will be displayed. 

 
 

The Toolbar buttons will activate as needed. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Notice that the Add button has been activated. 
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CREATING A CLASSROOM LAYOUT FILE, continued 
 

ADD ICONS TO THE GRID 
 
Click the red Add button to create new unit icons in the upper left corner of the 
window or to duplicate highlighted icons. 
 
Click the Add button multiple times to add more icons. 
 
Because your classroom will most likely include many more Student stations than 
other types of ViewNet stations, the ViewNet Layout default is set to create icons 
for Student units.  Create each icon you need as a Student unit first, and then 
follow the steps that will be provided later to change the appropriate icons to 
non-Student units. 
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CLASSROOM LAYOUT 
 

Place your pointer over an icon and hold down the left mouse button to drag the 
icon to the desired position on the grid.  Release the mouse button to drop the icon 
in place. 
 
Use the Cut, Copy, and Paste buttons to assist you in creating your layout. 
 
Highlight an icon and use the sizing handles on the box to customize the dimensions 
of the icon. 
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ICON PROPERTIES 
 

Now that you have created a preliminary simulation of your classroom, some of the 
icons must be changed to reflect their proper ViewNet unit. 

 
Place the cursor over the icon to be changed and right-click to display the icon's 
Properties dialog box: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Properties dialog box contains an Appearance tab and a ViewNet tab. 
 

 Appearance Tab 
 

The majority of the icon properties are changed from the Appearance tab.  The 
following paragraphs describe the properties in this tab. 

 
Label 

The icon label is displayed on the bottom edge of the icon.  The label field 
can be filled in with a generic name or individual student name.   
 
Each icon unit must have a unique name.  There are a few names that are 
reserved by Nida and cannot be used.  These names are All, This, Current, 
and Control. 
 

Border and Fill 
The border checkbox displays or hides the line around the icon. 
 
The Fill check box adds color or shading to the icon's background.  The 
default for Fill is transparent. 
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Appearance Tab, continued 
 
 
Default Type 
 

The Default Type box contains three radio buttons for identifying the type of 
icon.  The Type identification is used by ViewNet to categorize the icon for 
filing and enabling certain features.  The Default Type should match the 
Image. 

 
 

Image 
 

The Image box provides the icon graphic.  This selection should coincide 
with the Default Type. 

 
 
 
 
 
  ViewNet Tab 
 

The ViewNet tab allows you to activate or deactivate the icon for your ViewNet 
"control panel".  It also displays the icon address. 
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ADDRESS FEATURE 
 
When your classroom layout is complete with each unit assigned the proper label 
and image, the icons can be addressed. 

 
 
 

The address sequence will establish the Z-Order, that is, the order in which the 
units are viewed during the Scan routine in ViewNet Control. 
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ADDRESS FEATURE, continued 
 
 

Click View|Addresses to display the unit address on each icon. 
 
 

Highlight the icon that represents the first station you will want to view during the 
ViewNet Control Scan routine.   
 
 
Hold down the CONTROL key while you click the Bring to Front or Send to Back 
button.   
 
 
When the desired address number is displayed in the icon label, move to the next 
icon.  Repeat the process until all unit icons are numbered with an address. 

 
 
 
 
 
SAVING THE VIEWNET LAYOUT 

 
Click the Save button or select File|Save As to start a typical Windows save 
routine. The layout will be saved with the extension .VNL to the default ViewNet 
directory. 
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ALTERNATE ICON SET 
 

You can use an alternate set of icons for creating your graphical layout by selecting 
a new image library. 
 
Click File|Layout Properties.  The Layout Properties dialog box will appear.  In the 
Image Library field, the path to the current library of icons is displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Image Library field is defaulted to the standard Nida icons.  Click the dotted 
button next to the field to access the Open Image Library dialog box. 
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 ALTERNATE ICON SET, continued 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The alternate libraries carry an extension of .DLL. 
 
The library included with the ViewNet software, called ViewBasic.dll, is located in 
the ViewNet directory. 

 
Highlight the library file and click the Open button.  The Layout Properties dialog 
box will appear with the new library entered in the Image Library field. 

 
The new icons will be displayed in the window on the left side of the Layout 
Properties dialog box. 
 
Click OK to enable the new library.  All icons previously added to the dialog box will 
be changed to match the images of the new library's icons. 

 
 
 
 

 DESELECTING THE ALTERNATE ICON LIBRARY 
 

To return to the Nida default icon library, select File|Layout Properties and clear the 
Image Library field.   
 
Click OK to return your icons to the default parameters.   
 
Icons assigned images outside of the default list will be displayed with a green 
question mark.  Right-click these icons to change the properties back to a 
recognized default image. 
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VIEWNET CONTROL 
 

ViewNet Control is the operations center of the ViewNet system. 
 
From ViewNet Control, the instructor can: 

      
• monitor Student stations 

• broadcast to all or select Student monitors 

• from the Instructor station, take over an 
individual Student station 

• show an individual Student monitor display  
to the class or group of students 

 
 
 
 
VIEWNET CONTROL WINDOWS 
 

Double-click the ViewNet Control icon to open the ViewNet Control application.  
The windows of this program contain a menu, toolbar, and status bar for operating 
your ViewNet system. 
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VIEWNET CONTROL WINDOWS, continued 
 

Menu Bar 

      
The menu bar contains the File, Mode, View, Options, and Help drop-down menus. 
  
 
 

  File 
The File menu is a basic Windows menu that allows you to create, open, close, 
and save files. 
 
 

  Mode 
The Mode menu is disabled until a file is opened or created.  See the following 
page for a description of the activated menu. 
 
 

 View 
The View menu enables and disables the display of the Toolbar and Status Bar. 

 
 
 Options 

The Options menu contains two menu options, System and Restore Factory 
Defaults.   
 
The System option accesses the System Options dialog box that contains the 
Com Port settings; Scan, Test, and Status Rate settings; and activation options 
for Automatic Intercom and Ask for Secondary Group.   
 
The Restore Factory Defaults option resets your ViewNet units to the Nida 
defaults. 

 
 
 Help 

The Help menu displays the ViewNet Control version number and registration 
information.  Nida personnel may ask you for these details during a technical 
support call. 
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VIEWNET CONTROL WINDOWS, continued 
 
 Menu Bar, continued 
      
 

Mode   
When enabled, the Mode menu makes 
additional options available for performing key 
functions of the ViewNet 3000 system. 
 
 
 
Idle 

In this mode, the system is not active and the Overlay Editor is disabled. 
 
 
 
 Normal Operation 

When enabled, the Normal Operation mode activates the Broadcast, Scan, 
Monitor, and Takeover functions on the menus and toolbar. 

 
 
 

 Address 
When enabled, the Address mode makes the Address functions available.   
 
 
Address 

This menu starts and stops the 
addressing process and also provides 
a skip option used during 
addressing. 

 
 
 

 Overlay Editor 
When enabled, the Overlay Editor makes the Edit functions available. 
 
 

   Edit 
The Edit menu is displayed only 
when a file is open and the mode 
is set to Overlay Editor.  This 
menu is used to build groups and 
menus and to assign menus to 
icons. 
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VIEWNET CONTROL WINDOWS, continued 
 
 Toolbar 
 

 
 
 
 

            
The ViewNet Control toolbar contains buttons for accessing or performing certain 
operations.  Only the New and Open buttons are active until a .VNC file is opened. 

 
 New button 

The New button performs the same function as the selection of File|New from 
the menu bar.  It acts as a shortcut to open the Select Layout dialog box that 
displays the .VNL files created in ViewNet Layout. 

 
 Open button 

The Open button is also a shortcut for an item on the File menu.  When 
selected, it displays the Open ViewNet Class dialog box where the .VNC files 
are listed.  

 
 Save button 

This button saves the current file with its current file name.  If selected when a 
new file is on the screen, it will automatically open the Save As dialog box. 

 
 Navigation buttons 

The Navigation buttons are used during addressing, testing, and scanning to 
allow the instructor the commands of Start Over, Pause, Reverse, Forward, and 
Stop.    

 
 Takeover button 

When Mode|Normal Operation is selected, the Takeover button is used to 
assume control of the keyboard and mouse functions of a designated 
workstation. 

 
Secondary Broadcast button 

There may be times when the instructor wants the entire class to see the 
information that is displayed on a specific Student workstation.  The Secondary 
Broadcast button allows the instructor to take over a workstation's display and 
broadcast it to the rest of the class.  This button is always used in conjunction 
with the Takeover button. 

 
 Headset and Music buttons 

The Headset and Music buttons are disabled at this time. 
 

Help button 
The Help button accesses the online help and information windows. 
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VIEWNET CONTROL WINDOWS, continued 
 
 Status Bar 
      

The ViewNet Control Status Bar, located at the bottom of the ViewNet Control 
window, displays the current control system status and activated mode. 
 

 
 

 
 
It will display “Ready” when no functions are activated. 

 

 
 
 
 
 

ViewNet Control Toolbar/Keypad Correlation 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Takeover 

Stop 

Secondary  
Broadcast 
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CREATING A VIEWNET CONTROL FILE 
 

The first task required for using the ViewNet Control application is to make a 
ViewNet Control file (.VNC) from the ViewNet Layout file (.VNL) that was created in 
the ViewNet Layout program. 

 
The ViewNet Control file contains the layout and all the special control commands 
for operating the ViewNet 3000. 

 
To create the control file, open ViewNet Control and select File|New.  You will be 
prompted to select the .VNL file created in ViewNet Layout. 

 
It is recommended that you run the ViewNet 3000 with the Nida-provided default 
parameters until you become familiar with the system.  To enable the default 
parameters, immediately save the file as a .VNC file.  For easier retrieval, save the 
file in the ViewNet directory. 
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ADDRESSING YOUR VIEWNET UNITS 
 

Each ViewNet unit icon was assigned an address during the creation of the 
classroom layout.  The ViewNet units must now be addressed to provide the 
instructor with control over the classroom. 

 
 
      
ADDRESS MENU 
 

Select Mode|Address to add the Address menu to the menu bar.   
 
If changes were made to the layout file, a prompt will also be displayed reminding 
you to save the file before addressing.   
 
The Address menu contains three options:  Start, Skip, and Stop.   
 
During the address process, you can use            for Skip and for Stop. 

 
 
      
ADDRESS PROCESS 

 
The address process will begin at the unit icon identified as number 1.  This icon 
should match the physical location of your number 1 workstation.  If the location is 
different, return to the ViewNet Layout file and reassign the icon address order to 
reflect your classroom. 

 
During the address process, the icon borders will change colors to indicate the 
icon's addressing status.  The border colors and their indications are: 

 
      

 Grey Station Idle 

 Alternating Yellow/Green Station Ready To Be Addressed 

 Blue Station Addressing Complete 

 
 

To address a workstation unit, press [IR] on the workstation keypad (see 
Component #29 on Page 60) when the icon is displaying the alternating 
yellow/green border.  The border will then change to blue. 
 
Use the Forward navigation button to skip a unit during the addressing process.  A 
skipped unit will retain its address number; however, it will not be activated. 
 
For classrooms utilizing a keypad on the Instructor station only, the keypad must be 
moved from one ViewNet workstation unit to the next during the addressing 
process.  
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TESTING THE VIEWNET SYSTEM 
 

Select Mode|Test to display the test pattern window and begin the test routine. 
 
The test routine systematically moves from one ViewNet unit to the next, 
determining if the ViewNet system is connected correctly.  It first enables the 
Monitor function at each workstation and then the Takeover function. 
 
During the routine, a test pattern is displayed on the workstation under test, 
allowing the instructor or technician to check the ViewNet parameters for proper 
operation. 

 
 
TEST PATTERN WINDOW 
 

The Test Pattern window is divided into three sections: 
 

• RGB 

• whiteboard 

• test status 

 
 
 

RGB 

Whiteboard 

Test Status 
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TEST PATTERN WINDOW, continued 
 
 

RGB SECTION 
 
The RGB section is used to determine if the Red/Green/Blue video cables of the 
ViewNet system are connected correctly.  (See #5, #6, and #7 on Pages 56 and 57.) 
 
The colors on the monitor of the workstation under test should reflect the word in 
the color box.  Crossed or disconnected cables will cause a wrong color to be 
displayed in the associated color box. 
 
 

WHITEBOARD 
 

The Whiteboard section is used to test the ViewNet keypad.   
 
Test the keypad by pressing the keys.  The characters, with spaces separating 
them, will appear on the whiteboard at the Instructor station if the system is 
connected correctly. 

 
 

STATUS SECTION 
 

The Status section displays which workstation is undergoing testing and the test 
cycle currently being performed.  In the Monitor cycle, the instructor has full control 
over the Instructor keyboard and mouse.  During the Takeover cycle, the 
workstation under test has control of the Instructor keyboard input and mouse 
pointer. 

 
 

TOOLBAR BUTTONS 
 

The Navigation buttons on the toolbar are activated to assist the instructor or 
technician in moving from one workstation to another for testing.   
 
The Pause button can be used to halt the test on a specific workstation for 
troubleshooting.   
 
The Toolbar buttons cannot be accessed by the Instructor workstation when the 
test is in the Takeover cycle on a Student workstation.  Press [2] on the Instructor 
station keypad to pause the test during Takeover. 
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VIEWNET CONTROL NORMAL OPERATION 
 

The ViewNet software assists the classroom instructor by providing the ability to: 

• broadcast information to students 

• scan the classroom to monitor student progress 

• take over a workstation for demonstration or providing assistance 

• broadcast a Student workstation display to other students in the class 

• send the Instructor display to a projection system for a full multi-media 
presentation 

 
All of these functions are accomplished from the ViewNet Control window with 
Mode|Normal Operation selected. 

            
NOTE:  

      
Ensure that Steps 1-6 in the recommended sequence 

on Page 3 have been accomplished. 
 
 

      
VIEWNET CONTROL CLASSROOM REPRESENTATION 
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VIEWNET CONTROL CLASSROOM REPRESENTATION, continued 
      

The ViewNet Control window's graphic display is a duplication of the layout screen 
created in the ViewNet Layout program.  This screen should match the actual 
classroom configuration. 
 
To access function menus for operation of the ViewNet 3000 system, select 
Mode|Normal Operation and double-click or right-click an icon.  The toolbar buttons 
and the keypad will be activated as needed. 

 
 
 ICON COLOR SCHEME 
      

The unit icon for each ViewNet station displays specific colors in the border and 
lower color bars to depict specific operation functions.  The following explanation 
describes the icon color scheme and the functions it indicates. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

ITEM COLOR FUNCTION 

Border Grey ViewNet station is inactive 

Border Cyan Station is in sending mode 

Border Blue Station is in receiving mode 

Left color bar Dark Purple Waiting for command 

Left color bar Light Purple Takeover in progress 

Right color bar Bright Green Intercom ON 

Right color bar Dark Green Intercom OFF 

Both color bars Red Communication loss 

 

Border 
(three sides) 

Left color bar Right color bar 



ViewNet 3000 – Normal Operation  
  
 

  Copyright © 2000 
 

42 

VIEWNET CONTROL ACCESS TO FUNCTIONS 
 

With Mode|Normal Operation selected, double-click or right-click an icon to access 
the functions of the ViewNet 3000 system.  A menu of options will be displayed. 
 
 
 

 DOUBLE-CLICK AN ICON 
 
      

Double-click an icon to automatically start the assigned function. 
 
 
 
 

 
The Instructor unit icon is defaulted to the Broadcast function.   

 
 
 
This configuration enables the instructor to send the display on the Instructor 
workstation to all Student workstations by simply double-clicking the Instructor 
icon. 

 
 
 
 
 
 
 
 

The Student unit icon is defaulted to the Monitor function. 
 
 
 
This configuration allows the instructor to view the Student display on the 
Instructor workstation by simply double-clicking the Student icon. 

 
 
 
 
 
The double-click assignment is fully customizable.  (See Page 51.) 
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VIEWNET CONTROL ACCESS TO FUNCTIONS, continued 
 
 
 RIGHT-CLICK AN ICON 
 
      

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Right-click an icon to display a function selection menu.  Select an option from the 
menu to start the function routine. 
 

The Instructor unit icon menu is defaulted to the Broadcast and Scan functions, 
as shown above. 

 
The Student unit icon menu is defaulted to the Broadcast, Monitor, and 
Takeover functions. 

 
Menus are fully customizable.  (See Page 48.) 
 

 
 

For both methods of accessing ViewNet functions (double-clicking or right-clicking), 
the Stop button on the toolbar or [IR] on the keypad will stop the function. 
 
 
 
Icons assigned the “Other” type in ViewNet Layout do not have ViewNet functions 
attached; however, they can receive broadcast and scan signals.  The projector is 
an example of an icon assigned an “Other” type designator.  
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CUSTOMIZING YOUR VIEWNET CONTROL PANEL 
 

OVERLAY EDITOR 
 

The Overlay Editor mode allows customization of the control function of the 
ViewNet system.  Customizing menus and groups allows the instructor greater 
flexibility in monitoring and providing feedback to groups of students. 

 
Open a ViewNet Control (.VNC) file to activate the Mode option on the toolbar.  
(This function is disabled until a file is opened or created.) 
 
Select Mode|Overlay Editor to display the Edit menu on the ViewNet menu bar. 

 
 
 

EDIT MENU 
 

The Edit menu: 
      

• provides options for customizing Groups and Menus 
        

• lists the names of all of the groups currently active 
      

• allows changes to be made to the layout of any active group 
 
 
      

Customizing Groups 
 

Groups are customized in two different ways:  by name and by layout.   
 
Select Edit|Groups to display the Edit Groups dialog box.  This is where you can 
add, modify, or delete the names of groups. 
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Customizing Groups, continued 
 

Add a Group Name 
 

To add a group, click the Add button of the Edit Groups dialog box.  The Add 
New Group dialog box will be displayed. 
 

 
 
 
 
 
 
 
 
 
 
 

Enter the new name (Automotive) in the Group Name field of the Add New 
Group dialog box and click OK to add the new name to the Groups list. 
 
 

 
 

Modify a Group Name 
 

To change the name of a group, highlight a group in the Edit Groups dialog box 
and click the Modify button. 
 
The Modify Group dialog box will be displayed.  Change the name and click OK. 

 
 
 
 

Delete a Group Name 
 

To delete a group, highlight a name in the Edit Groups dialog box and click the 
Delete button. 
 
This option will only remove the particular group identified.  The main ViewNet 
Control layout will remain available for defining further groups as required. 
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Customizing Groups, continued 
 
 

Create or Change a Group Layout 
 
 
To change the make-up of a group, select Edit|XXX from the menu bar (where 
XXX = the name of the group you want to modify). 
 
 
Remember, for the Edit function to be enabled, a .VNC file must have been 
opened or created.  When you select the group name from the Edit menu, the 
layout grid for the file will be displayed, with icons representing the complete 
classroom. 
 
 
Icons that have already been included in the group have green borders.   
 
Icons that are available to be included in the group have gray borders. 
 
 
 
Double-click a unit icon either to add it to or delete it from the group. 

 
 
 

When you change modes or exit, you will be prompted to save your changes.  
Alternatively, you can select Save or Save As at any time to save your current 
changes. 

 
 
 
  See the following page for an illustration of customizing a group layout.
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Illustration: Customizing a Group Layout 
 

Consider the classroom layout below for an electronics class, which appears 
when we open our .VNC file, TestClass2.vnc.  We want to select the members to 
be included in the Automotive group we created in the previous section. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Edit is enabled on the menu bar because we have opened the .VNC file.  We select 
Edit|Automotive to identify the group we are customizing.  All of the icons appear 
with a gray border, because we have not yet identified any members for this new 
group.  We double-click the icons that represent the three stations we want to 
include in the Automotive group: 

      
 Student 3 

      
 Student 6 

      
 Spare  (The spare workstation is an automotive bench  

      that needs to be part of the group.) 
 
 

The borders on the icons we select turn green to indicate entry into the group. 
 

 
We have now defined our group of automotive/electrical workstations, and we can 
interact with them as a separate unit, without affecting the rest of the electronics 
class. 
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Customizing Menus 
 

When you double-click or right-click an active unit icon, you access the function 
menu which is assigned to that icon.   
 
The default menus that are automatically created when you make a new .VNC file 
have only a single item on the Double Click menu.  A menu with a single item is 
never displayed; it is immediately executed. 
 
The icon function menus are completely customizable. 

 
Select Mode|Overlay Editor to display the Edit menu on the ViewNet menu bar.  
 
Select Edit|Menus to display the Build Menus dialog box.  This box lists all of the 
menus available and allows you to add, modify, or remove a menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For example, let's use the Automotive group we created.  We will customize the 
Instructor menu so that we can easily broadcast a display from the Instructor 
station to only the workstations in the Automotive group. 

 
 
 

 Access the Build Menus dialog box, highlight Instructor, and click Modify. 
 
 
 
The Edit Menu dialog box is displayed. 



 ViewNet 3000 – Normal Operation 
  
 

Copyright © 2000  49 
 

Customizing Menus, continued 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Edit Menu dialog box lists the functions that can be accessed through the menu 
named in the Menu Title field.  In the instance above, the Instructor menu includes 
two functions: Broadcast and Scan.  You can add, modify, or remove menu items 
from this list by clicking the appropriate button. 
 
 
Add Menu Item 
 

To add the Automotive item for our current example, we would click Add to 
access the Add Menu Item dialog box. 
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Add Menu Item, continued 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fill out the Add Menu Item dialog box: 
 

• Enter the title of your new menu item in the Name field (Broadcast Auto). 
 

• Move to the Type field, and click the down arrow.  Make a selection from 
the drop-down list to assign a type (Broadcast). 

 
• Assign a Broadcast parameter in the From field by clicking the down 

arrow and making a selection from the drop-down list (Instructor). 
 
• Assign a Broadcast parameter in the To field by clicking the down arrow 

and making a selection from the drop-down list (Automotive). 
 
 

In the case illustrated above, we created an item called Broadcast Auto, which 
is a Broadcast type that transmits from the Instructor workstation to the group 
we created called Automotive. 
 
 
 
 
Now, whenever Mode|Normal Operation is selected and the Instructor icon is 
right-clicked, Broadcast Auto will be listed in the function menu that appears. 
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Assign Menus to the Mouse 
 

Right-clicking a unit icon accesses the function menu of that icon, and 
double-clicking the unit icon performs an assigned function. 
 
 
The mouse clicks for any individual icon can be customized to exact 
specifications.  Select Mode|Overlay Editor and right-click the icon to 
access the Select Menus dialog box. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

This box assigns menus to the Double Click or Right Click operation for the unit 
identified in the box.   

 
 

Click the down arrow at the right of each list box to display the available 
options.  The options include all the functions that have been created, either 
automatically (as a process of the .VNC file) or specifically (by an individual 
user). 
 
 
Since the double-click is usually a speed click to access your most utilized 
function, it is recommended that the Double Click field be limited to single item 
menus.  In our example above, the default of Broadcast remains as the Double 
Click assignment. 
 
 
By default, right-clicking the Instructor icon produces a function menu with the 
options of Broadcast and Scan.  However, we modified our Instructor menu to 
include the Broadcast Auto item.  With the Instructor menu assigned as above, 
when you right-click the Instructor icon, you will see Broadcast, Scan, and 
Broadcast Auto. 
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Customizing System Parameters 
 

To customize system parameters, select Options|System from the ViewNet Control 
menu bar.  The system parameters can be changed in any mode. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The System Options dialog box contains access for:  
 

• selecting the COM Port 
 

• enabling or disabling the Automatic Intercom and  
Ask for Secondary Group options 

 
• setting the number of seconds for Scan Rate and Test Rate 

 
• setting the number of milliseconds for the Status Rate 
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Systems Options Dialog Box 
 
 

Com Port 
      

The Com Port box contains radio buttons to enable the desired COM port that 
will interface with the ViewNet system from the Instructor or controller 
computer. 

 
      
      

Automatic Intercom 
 

 When the Automatic Intercom box is Deselected (not checked): 
      

The Automatic Intercom is deactivated.  The Intercom function must be 
manually enabled when required for the Instructor workstation to communicate 
privately with another location. 
 

      

 When the Automatic Intercom box is Selected (checked): 
      

The intercom connection is automatically activated between the instructor and a 
particular workstation when that workstation is placed in Monitor|Takeover.  
The two locations can communicate privately without disturbing the rest of the 
class. 
  
This workstation intercom is automatically disabled when the instructor 
deselects the Monitor|Takeover function. 

 
      

Ask for Secondary Group 
 

  When the Ask for Secondary Group box is Deselected (not checked): 
      

The Broadcast button on the ViewNet Control toolbar automatically uses the 
Everybody parameter.   
 
Clicking the toolbar button sends the monitor display to everybody in the 
classroom. 
 

      

 When the Ask for Secondary Group box is Selected (checked): 
      

The Broadcast button on the toolbar first offers a choice of parameters.   
Before the operation is performed, a selection is made from the menu that 
appears, listing all the groups (including Everybody).  
 
Clicking the toolbar button and selecting a group sends the monitor display to 
specific workstations as designated. 
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Systems Options Dialog Box, continued 
 
 

Scan Rate (s) 
 

The Scan Rate indicates, in seconds, the pause time at each Student 
workstation during the Scan function. 
 
This rate may be increased or decreased with the spin button adjacent to the 
Scan Rate field. 
 
The Scan Rate is defaulted to 5 seconds per workstation. 

 
 
 
Test Rate (s) 

      
The Test Rate indicates, in seconds, the pause time at each Student workstation 
during the Test function.   
 
This rate may be increased or decreased with the spin button adjacent to the 
Test Rate field.   
 
The Test Rate is defaulted to 10 seconds per workstation. 

 
 
 

Status Rate (ms) 
      

The Status Rate indicates, in milliseconds, the rate at which the system queries 
the workstations to determine if they are connected to the ViewNet system and 
functioning.   
 
This rate may be increased or decreased with the spin button adjacent to the 
Status Rate field. 

 
 
 
 

Defaults 
      

Click the Defaults button to reset your ViewNet Control configuration to the 
Nida-provided parameters indicated in the example of the Systems Options 
dialog box shown on Page 52.  
 
The Defaults button will not affect the COM Port setting. 
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RESTORE FACTORY DEFAULTS 
 

Select Options|Restore Factory Defaults from the ViewNet Control menu bar to 
return the individual ViewNet unit EPROMs to their factory-installed default 
settings. 
 
 
 
This option is available when Mode|Normal Operation is selected.  Basically, it 
restores unit settings that may have been tripped by another software program. 
  
 
 
 
 
If a unit or units appear unresponsive, select this option to clear the EPROM and 
reset the default parameters. 
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COMPONENT IDENTIFICATION 
 
The ViewNet 3000 is pictured and described below to facilitate your installation process 
and maximize your use of the system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.  ViewNet 3000 Control Unit (Top View) 
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Reminder:  Receptacles are the same on both Bus A and Bus B (see #2-#7).  However, for 
consistency and troubleshooting ease, it is recommended that you connect all 
Bus A receptacles on one unit to Bus B receptacles on the next unit. 

 
 

#1. AUDIO ADJUSTMENT:  This adjustment controls the signal level from AUDIO IN 
(see #12) and AUDIO OUT (see #13).  It is the only adjustment on the 
ViewNet 3000, and the default level is set at the factory.  

 
 

#2. INTERCOM:  This is the Main Intercom cable.  It uses a standard 4-wire cable with 
RJ11 connectors and is marked with the number 1.  There are two connectors on 
the ViewNet 3000 marked with the number 1. 

 
 

#3. CONTROL CABLE 2:  Control Cable 2 carries keyboard, mouse, takeover, and 
monitor signals.  It uses a standard 8-wire cable with RJ45 connectors and is 
marked with the number 2.  There are two connectors on the ViewNet 3000 
marked with the number 2. 

 
 

#4. CONTROL CABLE 3:  Control Cable 3 carries video control and video switching 
signals.  It uses a standard 8-wire cable with RJ45 connectors and is marked with 
the number 3.  There are two connectors on the ViewNet 3000 marked with the 
number 3. 

 
 

#5. VIDEO CABLE ARED@:  This video cable carries the red color signal and uses a 
standard 75-ohm coaxial cable with crimped-on connector.  The cable is marked 
with red color.  There are two connectors on the ViewNet 3000 marked with the 
letter AR". 

 
 

#6. VIDEO CABLE AGREEN@:  This video cable carries the green color signal and uses a 
standard 75-ohm coaxial cable with crimped-on connector.  The cable is marked 
with green color.  There are two connectors on the ViewNet 3000 marked with the 
letter AG@. 

 
 

#7. VIDEO CABLE ABLUE@:  This video cable carries the blue color signal and uses a 
standard 75-ohm coaxial cable with crimped-on connector.  The cable is marked 
with blue color.  There are two connectors on the ViewNet 3000 marked with the 
letter AB@. 

 
 

#8. LED:  When illuminated, this LED indicates the power is "ON". 
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Figure 3.  ViewNet Control Unit – External Connections (Top and Side Views) 
 
 
 

#9. RESET SWITCH:  This function allows for the readdressing of the unit and also 
eliminates a "system lock-up" condition. 

 
      
#10. MAIN STATION CONTROL CABLE:  The Main Station Control cable is connected to 

the ViewNet 3000 unit that will be designated as the main control station.  The 
opposite end of this cable will connect to the RS232 port on the computer 
containing the control software. 

 
      
#11. INTERCOM CONTROL BUS:  The Intercom connector allows inputs from the 

Keypad. This connection carries keyer response, intercom, and monitor reset 
signals. 

 
      
#12. AUDIO IN:  The Audio In connector is supplied for the purpose of feeding audio 

signals to the ViewNet 3000 from an external source. 
 
      
#13. AUDIO OUT:  The Audio Out connector is supplied for the purpose of feeding audio 

signals to an external device (e.g., speaker, headphone). 
 
      
#14. MAIN POWER:  This is the Main Power connector. 

9 
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Figure 4.  ViewNet Control Unit – Computer Connections (Top and Side Views) 
 
 
#15. VIDEO MONITOR:  The Monitor cable is connected to the monitor at the local 

station. 
 
      

#16. VIDEO COMPUTER:  The Computer cable is connected to the video card connector 
on the local computer. 

 
 

#17. KEYBOARD OUT:  The Keyboard Out cable is connected to the keyboard input on 
the local computer with the supplied PS/2-to-PS/2 cable. 

 
 

#18. KEYBOARD IN:  The Keyboard In connector accepts the cable from your local 
keyboard. 

 
 

#19. MOUSE OUT:  The Mouse Out cable is connected to the mouse input on the local 
computer with the supplied PS/2-to-PS/2 cable. 

 
 

#20. MOUSE IN:  The Mouse In connector accepts the cable from your local mouse. 
 
 

#21. USB IN OUT:  Not used at this time. 
      

 
NOTE: 

      
If repair parts are required, please contact your  
local ViewNet 3000 representative. 
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Figure 5.  Alphanumeric Keypad (Top and Side Views) 
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#22. VIEWNET UNIT INTERFACE CABLE CONNECTION:  This is the receptacle for 

ViewNet Interface cable.  
 

 
#23. POWER INDICATOR LIGHT:  This red light illuminates to indicate that power is 

applied to the unit.  
 

 
#24. FUNCTION/ANSWER DISPLAY:  This display indicates the letter or number entered 

via the keypad.  
 

 
#25. CLEAR ENTRY KEY:  This key clears the last entry entered via the keypad.  

 
 
#26. VOLUME CONTROL:  This wheel adjusts the volume of the headset earphones and 

microphone.  
 

 
#27. HEADSET EARPHONE CONNECTIONS:  This is the connection point for an optional 

headset.  
 

 
#28. MICROPHONE:  This is the connection point for an optional microphone.  

 
 
#29. IR KEY:  The functions of this key vary according to the operating mode that is in 

effect when the key is pressed:  
 

• In Normal Mode, the IR Key is used to signal the instructor that a student 
has a request. 

 
• In the Addressing Mode, the IR Key is used to identify the workstation to the 

Control program. 
 

• From the Instructor's Keypad, the IR Key is used to stop any activated 
function. 

 
 
#30. ALPHANUMERIC ENTRY KEYPAD:  This 10-number, 4-letter, 2-command keypad 

allows the entry of function commands or student answers in response to lesson 
questions.  

 
 
#31. INTERCOM QUERY:  This green light illuminates to indicate that the intercom is 

active.  
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HARDWARE INSTALLATION 
 
 
 

I-1. Using the four mounting holes, install the ViewNet 
3000 unit close to the computer and monitor at each 
station.  Good locations are on the underside of the 
workstation or on the wall directly behind the 
workstation if the workstation is against a wall. 

 
 
 
 
 

I-2. On all workstation computers, 
remove the monitor video cable 
from the computer and connect 
it to the ViewNet 3000 Monitor 
connector (see #15). 

 
 
 

I-3. Attach the supplied VGA cable 
between the computer VGA 
connector and the ViewNet 
3000 Computer connector (see 
#16). 

 
 
 
 
 

I-4. On all workstation computers, 
remove the keyboard cable and 
connect the keyboard to the 
ViewNet 3000 Keyboard In 
connector (see #18). 

 
 
 

I-5. Attach the supplied PS/2 cable 
between the computer keyboard 
connector and the ViewNet 3000 
Keyboard Out connector (see 
#17). 
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I-6. On all workstation computers, 
remove the mouse and attach the 
mouse to the ViewNet 3000 
Mouse In connector (see #20). 

 
I-7. Connect the supplied PS/2 cable 

between the computer mouse 
PS/2 connector and the 
ViewNet 3000 Mouse Out  
connector (see #19). 

 
 
 
 

I-8. Check connections between all of the 
workstation computers and the 
ViewNet 3000 units.  The connections 
should be as shown. 

 
 
 

NOTE: 
      
Receptacles are the same on both Bus A and 
Bus B (see #2-#7).  However, for consistency 
and troubleshooting ease, it is recommended 
that you connect all Bus A receptacles on one 
unit to Bus B receptacles on the next unit. 
 
 
 
 

I-9. Attach one coaxial cable between the first 
ViewNet 3000 connector marked B and the 
second ViewNet 3000 connector marked B 
(see #7). 

 
I-10. Attach another coaxial cable between the 

B connectors on the second and third 
ViewNet 3000 units. 

 
I-11. Continue until coaxial cables are attached 

between all B connectors on all of the 
ViewNet 3000 units in a daisy chain 
configuration. 

 
 

 

 

 

  

 

 

 
TO NEXT
VIEWNET

UNIT

SECOND
VIEWNET

UNIT

FIRST VIEWNET UNIT
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I-12. Attach one coaxial cable between the first 

ViewNet 3000 connector marked G and the 
second ViewNet 3000 connector marked G 
(see #6). 

 
I-13. Attach another coaxial cable between the G 

connectors on the second and third 
ViewNet 3000 units. 

 
I-14. Continue until coaxial cables are attached 

between all G connectors on all of the 
ViewNet 3000 units in a daisy chain 
configuration. 

 
 
 

I-15. Attach one coaxial cable between the first 
ViewNet 3000 connector marked R and the 
second ViewNet 3000 connector marked R 
(see #5). 

 
I-16. Attach another coaxial cable between the R 

connectors on the second and third ViewNet 
3000 units. 

 
I-17. Continue until coaxial cables are attached 

between all R connectors on all of the 
ViewNet 3000 units in a daisy chain 
configuration. 

 
 
 

I-18. Attach one 8-conductor flat cable between 
the first ViewNet 3000 8-conductor 
connector marked 3 and the second 
ViewNet 3000 8-conductor connector 
marked 3 (see #4). 

 
I-19. Attach another 8-conductor cable between 

the connectors marked 3 on the second and 
third ViewNet 3000 units. 

 
I-20. Continue until 8-conductor flat cables are 

attached between all connectors marked 3 on 
all of the ViewNet 3000 units in a daisy chain 
configuration. 
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I-21. Attach one 8-conductor flat cable between 

the first ViewNet 3000 8-conductor 
connector marked 2 and the second ViewNet 
3000 8-conductor connector marked 2 (see 
#3). 

 
I-22. Attach another 8-conductor cable between 

the connectors marked 2 on the second and 
third ViewNet 3000 units. 

 
I-23. Continue until 8-conductor flat cables are 

attached between all connectors marked 2 on 
all of the ViewNet 3000 units in a daisy 
chain configuration. 

 
 

I-24. Attach one 4-conductor flat cable between 
the first ViewNet 3000 4-conductor 
connector marked 1 and the second 
ViewNet 3000 4-conductor connector 
marked 1 (see #2). 

 
I-25. Attach another 4-conductor cable between 

the connectors marked 1 on the second and 
third ViewNet 3000 units. 

 
I-26. Continue until 4-conductor flat cables are 

attached between all connectors marked 1 
on all of the ViewNet 3000 units in a daisy 
chain configuration. 

 
 
 
 
 

I-27. Attach the supplied round 9-pin 
connector between the Keypad and 
the Intercom connector on each 
ViewNet 3000 unit (see #11).  If only 
one Keypad was supplied, it must be 
connected to the main station during 
normal operation. 
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I-28. Attach the provided power supplies 
to all the Power connectors on all 
the ViewNet 3000 units (see #14).  

 
 
 
 
 

I-29. Connect all the power supplies to 
110 VAC outlets. 

 
 
 
 

I-30. Connect the supplied  
8-conductor flat cable to the

 9-pin DSUB–to–RJ-45  
adapter. 

 
 
 
 

I-31. Connect the 9-pin adapter to the main 
station computer serial port  (Com 1 or 
Com 2). 

 
 
 

 
 
 
 
 
 
 
 

I-32. Attach the 8-conductor flat 
cable to the main station 
ViewNet 3000 Control 
connector (see #10). 

 

MAIN POWER 
CONNECTOR 

 

8-CONDUCTOR FLAT CABLE

9-PIN DSUB–to–RJ-45 ADAPTER

COM 
PORT 

   CONTROL 
CONNECTOR 8-CONDUCTOR FLAT CABLE

9-PIN ADAPTER

 

COM 
PORT 

8-CONDUCTOR FLAT CABLE 

9-PIN ADAPTER 
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 INDEX

A 

Addressing ViewNet units, 37 
Alternate Icon Set, 28 
Ask for Secondary Group system 

parameter, 53 
Automatic Intercom system parameter, 53 

C 

Classroom layout, creating a, 21 
Com Port system parameter, 53 
Component identification 

Computer connections, 59 
External connections, 58 
Keypad, 60 
ViewNet 3000, 56 

Control file, creating a, 36 
Customizing 

Groups, 44 
Menus, 48 
System parameters, 52 

D 

Defaults 
Restore factory defaults, 55 
System parameters, 54 

G 

Groups, customizing, 44 

H 

Hardware Installation, 62 

I 
Icon Properties, 24 
Icons 

Adding to grid, 22 
Alternate libraries, 28 
Border color indications, 37 
Color scheme, 41 

Installation 
Hardware, 62 

L 

Layout Properties, 19, 28, 29 

M 

Menus 
Assigning to the mouse, 51 
Customizing, 48 

N 

Normal operation, 40 

O 

Overview of ViewNet 3000, 1 

S 

Scan Rate system parameter, 54 
Status Rate system parameter, 54 
System parameters, customizing, 52 
System Setup Tables 

Address ViewNet units, 15 
Checklist, 3 
Set icon properties, 13 

T 

Test Pattern window, 38 
Test Rate system parameter, 54 
Testing the ViewNet system, 38 

V 

ViewNet Control, 31 
Customizing, 44 
Menu bar, 32 
Operation, 42 
Status bar, 35 
Toolbar, 34, 35 
Toolbar/Keypad correlation, 35 

ViewNet Layout, 18 
Address feature, 26 
Menu bar, 19 
Toolbar, 20 

ViewNet Operation Tables 
Broadcast Instructor Display to All, 6 
Major Functions, 5 
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